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Rich's lesson module checklist Last updated 02/02/2019

❑ Putty + Slides + Chrome

❑ Enable/Disable attendee sharing

^ > Advanced Sharing Options > Only Host

❑ Enable/Disable attended annotations

Share > More > Disable Attendee Sharing

❑ https://zoom.us

❑ During FLEX week
❑ Update website and Canvas

❑ Lesson 1, Lab 1, survey, PW sheet, other supplemental materials posted
❑ Canvas course and module 1 published for interested students to review
❑ Login credentials document updated and secured

❑ Day before first class
❑ Send out welcome email
❑ Reset permissions on answers/
❑ Change website to show "Term days left"
❑ Accounts

❑ Opus-II (with TBDs for walk-ins) and populated 
❑ VLab, Aryas, Scavenger systems, Lights XC, Netlab+, Home-ZeroW, Daughter & Son
❑ Mugshot slide updated
❑ VLab VM assignment sheet updated and posted

❑ Last forum archived, phpBB updated to latest version, new forum created with welcome post
❑ Scavenger Hunt Lab 1 

❑ Tested (check Mac Freedom and log rotate issues)
❑ Update and test grading script
❑ Trekkie sample logins

❑ Scavenger monitor(Opus-ii:login-monitor) cronjob
❑ VLab monitor(Monitor:monitor-27.py) cronjob

❑ Rosters printed 
❑ Add codes printed 

❑ Flash cards 
❑ 1st minute quiz  
❑ Update Calendar page

❑ Backup slides, whiteboard slides, lab, credentials on flash drive 
❑ Test and bring home-ZeroW
❑ Print out agenda slide and annotate page numbers
❑ Key card for classroom door

https://zoom.us/
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Before first class starts
Everyone into the virtual room!

1. Log into Canvas, read my 
Announcement and review the 
credentials document.

2. Go to: http://simms-teach.com
a) Click the CIS 90 link.
b) Click the Calendar link.
c) Locate today’s lesson.
d) Find the Presentation slides for 

Lesson 1 and download them for 
easier viewing.

e) Click the Enter virtual 
classroom link to join 
ConferZoom meeting.

3. If successful help another student in 
the room till everyone gets in!



CIS 90 - Lesson 1

3

❑ CIS 90 website 
Calendar page

❑ Google ❑ ConferZoom

❑ Downloaded PDF of Lesson 
Slides. I like Foxit Reader so I 
can take notes by annotating the 
downloaded slides.

Before first class starts

Set up your computer as shown above
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Start
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Start
Recording

Audio Check
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Start Recording

Audio & video
Check
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Objectives Agenda

• Understand how this course works

• Overview of computers and 

UNIX/Linux

• Learn how to login via ssh

• Learn first UNIX/Linux commands

• Introductions

• Why take this class

• How this class works

• Lab resources

• Computers

• UNIX/Linux Overview

• Logging in via SSH

• First login

• First commands

• Housekeeping

• Navigating systems

• Assignment

• Wrap up

Class and Linux Overview

8
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Introductions
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Introductions and Credits
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Jim Griffin 
• Created this Linux course
• Created Opus and the CIS VLab
• Jim’s site: https://web.archive.org/web/20140209023942/http://cabrillo.edu/~jgriffin/

Rich Simms 
• HP Alumnus
• Started teaching this course in 2008 when Jim went 

on sabbatical
• Rich’s site: http://simms-teach.com

And thanks to:
• John Govsky for many teaching best practices: e.g. the First 

Minute quizzes, the online forum, and the point grading 
system.  John's site: 

• Jaclyn Kostner for many webinar best practices: e.g. mug shot 
page.

http://teacherjohn.com/

https://web.archive.org/web/20140209023942/http:/cabrillo.edu/~jgriffin/
http://simms-teach.com/
http://teacherjohn.com/
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Email me (risimms@cabrillo.edu) a relatively current photo of your face for 3 points extra credit

Instructor:  Rich Simms
Dial-in: 669-900-6833 (toll) 
Meeting ID: 426 283 384

Ryan

Daniel

DavidErik Cody

LuckyScottSequoiaIvan ShaneCole Jim

Mark tbdtbdEvieOhunayo Jake tbd

Nick AdinaJon

Tanisha

Wais

CherylMatthew

Joseph
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ConferZoom Activity

Use the chat window in ConferZoom to say Hi to 
your adjacent “virtual classmates”

If your name is not listed above just chat Hi to 
anyone you want!

Ryan

Daniel

JonDavidMatthewErik

Tanisha

Cheryl Cody

LuckyScottSequoiaAbdellatif ShaneCole James

JosephMark tbdtbdtbdOhunayoWais tbd tbd

Nickolaus Adina
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What is this 
class about?
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CIS 90
Introduction to

UNIX/Linux

The Command Line

16

Shell
commands

Pipes

Shell scripting

Permissions

Mail

Navigate
file treeProcesses

Filters

Files and
directories

Secure logins

Scheduling
tasks

vi editor

Environment
variables

Student Learner Outcomes
1.Navigate and manage the UNIX/Linux file system by viewing, copying, 

moving, renaming, creating, and removing files and directories.

2. Use the UNIX features of file redirection and pipelines to control the 
flow of data to and from various commands.

3. With the aid of online manual pages, execute UNIX system commands 
from either a keyboard or a shell script using correct command syntax.
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How this 
class works
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Attending
class
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How to attend class each week

It doesn't matter which section you enrolled in.  You can use any method of 
attending for any of the classes.

Option 1: Online “synchronous” - from anywhere connect 
online to the "live" virtual classroom using ConferZoom.  Use the 

“Enter virtual classroom” link on:

Option 2: Traditional classroom - drive to campus, find parking, 
hike to the 800 building and take a seat in the classroom.

Option 3: Online archives “asynchronous” - watch the 
archived class recording online using ConferZoom at a time that 
works for you. Use the “Class archives” link on: http://simms-teach.com/cis90calendar.php

http://simms-teach.com/cis90calendar.php

http://simms-teach.com/cis90calendar.php
http://simms-teach.com/cis90calendar.php
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Attending
Class

(supplemental)
20
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Option 1: Online (synchronous) - from anywhere connect online to 
the "live" virtual classroom using ConferZoom.

21

1. Browse to http://simms-teach.com
2. Click the CIS 90 link
3. Click the Calendar link
4. Click any Enter virtual classroom link

1

2

3

4
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Enjoy the ocean view from the 
classroom windows!

Building 800 - Room 828

Option 2: Traditional - drive to campus, find parking, walk to the 
800 building and take a seat in the classroom.
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1. Browse to http://simms-teach.com
2. Click the CIS 90 link
3. Click the Calendar link
4. Click any Class archives link

Option 3: Online archives (asynchronous) - watch the archived 
class recording online using ConferZoom at a time that works for 
you.

1

2

3

4
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ConferZoom
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ConferZoom

Zoom application, host is not sharing anything
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Help the Instructor with ConferZoom

Everyone, even students in the traditional classroom,  
should join into ConferZoom for the live class.  

Traditional classroom students:

• If you notice an online student with an unanswered 
question please let the instructor know.

• If you notice the instructor forgot to share the 
presentation material please let the instructor know.

• If you notice the instructor forgot to turn on recording
please jump up and down and wave your arms to let the 
instructor know!
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Zoom application, host is sharing lesson slides
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ConferZoom Activity

If you are not 
asking a 
question please 
mute your 
audio.

If you are 
eating potato 
chips please 
mute your 
audio!

If your dog is 
barking please 
mute your 
audio!

Hover over your name 
on the list to display 
the Rename button.  
You can use this to 
make your name be 
your preferred first 
name.
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ConferZoom Activity

Try raising and 
lowering your hand a 
few times.

Please raise your 
hand when you have 
a question or would 
like to be called on to 
speak.
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View Options > Annotate > Draw > "✓"

ConferZoom Annotations

Find the annotation 
drawing tool for a 
checkmark.
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ConferZoom Activity

Other

Place an ✓ to indicate the operating system is your computer running.
(View Options > Annotate > Draw > ✓)
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View Options > Annotate > Draw > X

ConferZoom Annotations

Find the annotation 
drawing tool for an "X".
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ConferZoom Activity 

Mark your location with an X
(View Options > Annotate > Draw > X)
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View Options > Annotate > Draw > /

ConferZoom Annotations

Find the annotation 
drawing tool for a 
straight line.
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Connect the matching images with a straight line 
using your favorite color.

(View Options > Annotate > Draw > /)

ConferZoom Activity 
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View Options > Annotate > Arrow

ConferZoom Annotations

Find the annotation 
drawing tool for the 
"named" arrow.
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If you could instantly transport to one of these 
places this weekend where would you go?

Use your "named" arrow to pick one.

ConferZoom Activity 
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Roll Call 
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Instructor Note:

PAUSE Recording,
and do a roll call using 

latest roster
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If you are attending class by 
watching the recordings in the 

archives email the instructor at: 

risimms@cabrillo.edu 

to provide roll call attendance.
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Instructor Note:

RESUME Recording,
continue with lesson 

slides
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Syllabus, 
Calendar 

and Grades
42
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simms-teach.com
Find the syllabus

CIS 90

1. Browse to http://simms-teach.com
2. Click the CIS 90 link
3. Click the Course Home link

3

2

1
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Optional Textbook:

Harley Hahn's Guide to Unix and Linux
by Harley Hahn
McGraw-Hill ISBN: 0073133612

This textbook is optional but nice to have if you want to dig deeper 
into the material provided by the lesson slides. 

I really like the very first sentence in Harley 
Hahn's book:

"This book will change your life."  

Optional CIS 90 Textbook
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If you find your really enjoy learning UNIX/Linux and want your own 
private server then you should consider:

$35.00 Raspberry Pi 3 - Model B or B+
$7.50 5V 2.4A Switching Power Supply with 20AWG MicroUSB Cable

$14.95 16GB Card with NOOBS 2.1

If you like “hands-on” you will love a Raspberry Pi

Optional CIS 90 Gear

https://www.adafruit.com/category/105

https://www.adafruit.com/category/105


CIS 90 - Lesson 1

CIS 90 Spring 2019

Class meets in room 828 and online every Wednesday morning:

• 15 lessons: 9:00AM-12:05PM, from Jan 30th to May 15th

• Final exam: 7:00AM-9:50AM, on WEDNESDAY May 22th, in room 828

46
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The typical week 
http://simms-teach.com

Work on labs or practice tests 
during the week.  

All assignments and due dates 
are on the Calendar page

Thursday
is grading day

Calendar
All due dates are 

found here

49

Wednesday
"First minute" quiz

Lecture on new lesson material
Class activities

Previous week lab assignments 
due 11:59PM (Opus-II time)

Peek at the Extra Credit 
page if you need more 
points

Use the 

to collaborate 
with classmates 
at any time

Check the Grades
page to see grades 
on labs, quizzes 
and tests

Forum
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Contacting the instructor
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• Use the forum for the fastest response on technical or class 
related questions.

• Use email for personal matters.  If it’s not personal I will 
probably encourage you to post your question on the forum so 
I can answer it there.  This is preferable because your other 
classmates can benefit from the answer.

• Weekly office hours on Cabrillo A-Z Directory website:

• Avoid leaving a message on voice mail. Checked rarely so don’t 
expect a fast response (if any)!

http://babyface.cabrillo.edu/salsa/listing.jsp?staffId=1426

http://babyface.cabrillo.edu/salsa/listing.jsp?staffId=1426
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simms-teach.com
Find the Calendar page

CIS 90

1. Browse to http://simms-teach.com
2. Click the CIS 90 link
3. Click the Calendar link

3

2

1
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Course Calendar

Supplemental 
references to 
material in the Gillay
and Hahn textbooks

What is due by 
11:59PM (Opus-II 
time) on that date 
(LATE WORK IS 
NOT ACCEPTED)

Lesson slides, feel 
free to download 
during class for 
local viewing

Assignment for 
next class

First minute quiz

Test

Lesson # and Date

52

Links to virtual 
classroom and 
archived recordings

ConferZoom links 
to join class online 
or watch archived 
recordings http://simms-teach.com/cis90calendar.php

http://simms-teach.com/cis90calendar.php
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Best Practices for using the Lesson Slides
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http://simms-teach.com/cis90calendar.php

Download and 
open them in a 

tool like Foxit 
Reader so you 

can mark them 
up with notes 

and annotations.

Keep a browser open so 
you can look up terms 
you are not familiar with 
or open links in the 
lesson slides.

https://www.foxitsoftware.com/pdf-reader/

http://simms-teach.com/cis90calendar.php
https://www.foxitsoftware.com/pdf-reader/
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simms-teach.com
Find the Grades page

CIS 90

1. Browse to http://simms-teach.com
2. Click the CIS 90 link
3. Click the Grades link

32

1
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Each student is 
assigned a secret 
LOR code name

Your default 
grading choice will 
be a letter grade.

There is an eForm
in WebAdvisor to 
request a change 
to Pass/No Pass 
which must be 
submitted and 
approved by the 
college deadline.

Monitor this page to 
track your progress 
in the course.

Your grade is based solely on the 
number of points you earn.  It offers 
flexibility and gives you control.

Use extra credit 
to earn up to 90 
additional points

Course Grading
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You control your grade. The more points you earn the 
higher your grade will be.

More on Grading
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Starting Fall 2018 you must use the new eForm on 
WebAdvisor to request the Pass/No Pass grading 
option.

There is a college deadline for this and changes are 
irreversible!

Letter Grade or Pass/No Pass



CIS 90 - Lesson 1

• 10 labs, 30 points each

• Due at 11:59PM (Opus-II time) on the date shown on the course Calendar.

• Late work is not accepted. There is no credit for any work turned in after the 
deadline. If you don't complete a lab assignment, please turn in what you have, 
by the due date, for partial credit.

• Students may work together and collaborate on labs but they must submit their 
own work to get credit.

• Lab resources, instructors, and assistants are available in the CIS lab. In 
addition the Linux Opus-II server and the CIS VLab may be accessed from 
anywhere over the Internet. 

58

Grading - Lab Assignments

A lab assignment due at 11:59PM will get no credit if turned in 
one minute late at 12:00AM which is midnight the next day!
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• 10 quizzes, 3 points each

• The quiz questions are shown on ConferZoom at 9:00AM sharp. Answers are 
emailed to the instructor. The order of the questions will not be known until the 
quiz is given! Emailed answers that are not in order will be marked as 
incorrect.

• The quiz questions are given out in advance and students can use the forum to 
collaborate on answers prior to class.

• Quizzes are open book/notes.  Students may not give or ask others for assistance 
while taking a quiz.

• There are NO makeup's for these quizzes and they must be taken and turned in 
within the first few minutes of class. Answers emailed after the first few minutes 
of class will not get credit.

• Students that attend by watching the archives can do some extra credit work 
instead.  In the past many working students have joined the class briefly at the 
start just to take the quiz and then return to work.

59

Grading - First Minute Quizzes

An incentive to start class on time
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Grading - Tests

Timed tests are more difficult due to the time pressure!  They do help me understand 
what you have learned so I can adjust the course as needed. 

If you get anxious, freeze up, or your mind just doesn't work on timed tests then 
come see me. I'll be happy to work with you on how to successfully take them.

• 3 tests, 30 points each

• Tests are timed.

• A practice test will be made available a week before the actual test.

• Test 1 and 2 will be held during the last hour of class on the days shown on the Calendar.

• Working students have the option to take test 1 and test 2 later in the day but they must 
be completed no later than 11:59PM (Opus-II time) on the day of the test.

• Test 3 is the final exam and is mandatory.  The time of the final exam is shown on the 
Calendar.

• Tests are open notes, open book, and open computer.

• Students may not give or ask others for assistance while taking a test.

• Tests may be taken remotely online.  
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• 4 points per post, up to 20 points maximum per "posting quarter".

• The end date for each posting quarter is shown on the course calendar.

• The posts for the quarter will be due at 11:59PM (Opus-II time) on the date 
shown on the course Calendar.

• Extra posts in one quarter do not carry over to the next quarter.

• Only posts in the CIS 90 class forum will be counted.

62

As far as earning points, forum posts are "low hanging fruit" !!

Grading - Forum Posts



CIS 90 - Lesson 1

• Up to 90 points.

• You need to attend to a family emergency and can't turn in a lab assignment on 
time … don't worry!

• Your schedule/commute doesn't allow you to take any of the "first minute" 
quizzes …. don't worry!

• You get anxious, panic and forget everything you know on a test … don't worry!

• You just don't like making forum posts … don't worry!

63

There are ample extra credit opportunities which provide you with 
the flexibility to get the grade you want.

There is a cap on extra credit points so plan carefully!

Grading - Extra Credit
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Making the fine print LARGE (and BOLD)

Please remember:

1) NO makeup's for missed quizzes.

2) Quiz answers in the wrong order or not emailed in the first few 
minutes will not be accepted.

3) Late work will not be accepted.  For example, a lab assignment due at 
11:59PM will get no credit if turned in one minute late at 12:00AM 
(midnight) the next day.

Tip: if you have not completed a lab assignment, please turn in what you have 
done for partial credit.

Don’t panic though -- there are ample extra credit opportunities for students 
wanting or needing any extra points.

64
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• You control your grade for this course!

• Use the Grades web page to plan for the grade you wish to receive 
and track your progress.

• Use the Calendar web page to see due dates for ALL lab assignments,  
extra credit labs and forum posts.  See when EVERY quiz and test is 
scheduled.

65

Final word on Grading

At the end of the course the 
instructor will count the number of 
points you have earned and use this 
table on the Grades web page to 
determine your grade.

Grades Calendar
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Help
Forum

66
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Online Help Forum

• Post questions and answers

• Get clarifications on assignments

• Collaborate with classmates on assignments, 
quizzes and practice tests.

• Share UNIX/Linux information and ideas

• Post class notes for classmates who miss class

• Since this is a public forum on the Internet:

• Never post passwords!

• Be nice, respectful, supportive and 

professional.

As an incentive to use the forum - students can earn 4 points per 
CIS 90 forum post (capped at 20 points for each posting period)

67
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Class Forum

• No anonymous usernames!  Your username must 
be:

• Your real first and last name separated by a 
space e.g. Rich Simms

• During activation if your username matches a 
name on the roster, but is not your full first 
and last name it will be modified to be so.

• During activation if your username does not 
match a name on roster it gets deleted and 
you need to try again.

• Uploading an avatar is optional.  Identifying 
photos are preferred so students can get to know 
each other. 68



CIS 90 - Lesson 1

Class Activity
Forum Registration

69

Click the Forums link on 
http://simms-teach.com

Note:  All registrations are manually approved by the instructor. If your username is 
incomplete or does not match a name of the class roster it will be modified or deleted.

To Register:

1. Browse to the forum

2. Click on 

3. Review and agree to terms

4. Your Username must:

• be your first and last name 
separated by a space e.g. 
Benji Simms 

• match a name on the class 
roster

Note:  If you have already 
registered in a previous CIS course 
you don’t need to do it again.  
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Subscribe to the forum to get email notifications of new posts

After logging in:

1. Go to the CIS 90 class forum.
2. At the bottom of the page, click the "Subscribe forum" link on the 

lower left.  When subscribed you get email notifications when new 
posts are made.

3. To unsubscribe, click it again.

Unsubscribed 
looks like this.

Subscribed 
looks like this.

To get notifications of new forum posts
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Lab 
Resources

71
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The CIS 90 System Playground

73

Configured for

Command Line Only
Configured for

Graphics and Command Line

All the systems are virtual machines 
(VMs) running on the CIS Lab servers.  
They are available from on or off-campus 

Opus-II

Sun-Hwa-XX servers for tests

Arya-01

Each student gets their 
own Arya VM for the term

Defiant
Lexington

Enterprise
Intrepid

Freedom
Excalibur

Son-of-Opus
Daughter-of-Opus

Baby-Opus and MORE

Other UNIX/Linux servers
Arya-75
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The CIS 90 System Playground

My micro lab on my desk at home.  Watch the forum 
for an extra credit activity using this tiny lab.
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The CIS 90 systems, e.g. Opus-II and 
Sun-Hwa, are virtual machines hosted 
on physical servers in the CIS Lab

Internet

Option 1: Work on assignments online from anywhere

CIS Lab servers on 
the Aptos campus

Home School

75

Travel
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Option 2: Work on assignments in the CIS Lab

Instructors, lab assistants and equipment 
are available CIS students.  

Great place to collaborate with classmates 
and a place for study groups to meet.

Building 800 - Room 830 (in the STEM Center)

Use this link to see 
schedule and location
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Option 3: Work on assignments in the CTC

CTC (building 1400) on lower campus
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Computers
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79At a high level all computers have the same basic hardware and software components

Hardware Software

Memory

CPU

Network
Interface

Motherboard

Permanent Data Storage

Applications “Apps”
(programs)

Operating 
System

What is a computer?
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Hardware

80
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Computer hardware has many form factors

smart 
phone

tablet

desktop

mobile
"laptop"

blade 
server

"pizza box" 1U 
rack server

"heavy iron" 
server

supercomputerVirtual 
Machine

Raspberry Pi

Computers come in a wide variety of form factors

smart watch
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Software

82
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Software can be divided into programs (apps) 
and operating systems

Applications “Apps” (programs)
• Interface to users via graphics (GUI) or command line (CLI)
• Use the OS for all access to hardware resources

Examples: word processors, spreadsheets, smartphone apps, web servers, 
compilers, games, email, web browsers, media players, databases, CAD/CAM, 
contact management, anti-virus, accounting, enterprise applications, custom 
software, and millions more!

Hardware

Users

83

Operating System (OS)
• Shares hardware resources
• Loads and executes programs
• Manages processes (running programs)
• Manages memory

Examples:  Windows, Mac, Linux, Unix

• Manages the file system 
• Provides input/output services
• Monitors the system
• Network stack services
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Software Licensing

Public Domain (paid for by the taxpayer)
• Source code is available

• No license, no copyright, maybe modified and redistributed

• Examples: USGS mapping software, NASA aerodynamics software

Open Source
• See: http://opensource.org

• Source code is available

• Community of developers doing online collaboration

• Pragmatic redistribution licenses

• Examples:  Apache, Firefox, Android, OpenOffice, OpenBSD, LibreOffice

Free Software Foundation 
• See: https://www.fsf.org

• Source code is available

• GNU (“GNU is not UNIX”) General Public License, COPYLEFT

• Examples: GNU/Linux, gimp, emacs, nano, gcc, zebra, Files 

Proprietary (closed source)
• Source code is not available

• Considered intellectual property

• Must be licensed to use

• Examples:  Adobe Photoshop, Microsoft Windows, Mac OS X, AT&T UNIX System V, 

Cisco IOS
84
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UNIX/Linux
overview
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In 1971 Ken Thompson and 

Dennis Ritchie developed 

Unix at AT&T's Bell Labs

In 1971 Ken Thompson and Dennis Ritchie developed Unix at AT&T's Bell Labs
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Isn’t UNIX/Linux an antique 
Operating System dating back to the 
early 70’s that belongs in a museum?
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Heck NO !!
UNIX/Linux is widely used, constantly improved and growing fast!

• Cloud infrastructure – Amazon AWS, OpenStack, etc.

• Embedded in smartphones, tablets and many other appliances.

• Internet services - Web, DNS, DHCP, Net News, Mail, etc.

• Enterprise and mission critical applications - Large databases, Enterprise 
Resource Management (ERM), Customer Relationship Management (CRM), 
data warehouse, manufacturing, supply chain management, etc.

• Hollywood - feature animation, visual effects, rendering farms.

• Number-crunching super computers for research.

• Businesses like Amazon, Paypal, Facebook, NYSE, Google, Home Depot run 
their businesses on UNIX/Linux\

• Crypto currency mining rigs
88

http://www.comparebusinessproducts.com/fyi/50-places-linux-running-you-might-not-expect
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UNIX/Linux
Overview

Supplemental
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Businesses and 
organizations that 

run on Linux

http://www.comparebusinessproducts.com/fyi/50-places-linux-running-you-might-not-expect
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Internet service providers use 
UNIX/Linux to provide web, DNS, DHCP, 
Mail, etc. services to their customers.

91
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Film Studios

92

Film studios like DreamWorks have huge 
Linux "rendering farms" to produce the 
animation and special effects



CIS 90 - Lesson 1

93

< snipped >

http://www.zdnet.com/blog/open-source/the-open-source-car/9193

http://www.sony.net/Products/Linux/common/search.html

Televisions
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Unix
family
trees
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Source: http://upload.wikimedia.org/wikipedia/commons/thumb/5/51/Unix_history.svg/705px-Unix_history.svg.png

BSD family

GNU/Linux

Commercial 
UNIX family

It all 
started 
at Bell 
Labs

Apple family
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Unix family 
Trees

Supplemental
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97Source: http://www.freebsdnews.net/wp-content/uploads/unix_family_history_tree_1600x1200.jpg

UNIX/Linux Family Tree
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Source: http://en.wikipedia.org/wiki/Unix#mediaviewer/File:Unix_history-simple.svg
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http://www.levenez.com/unix/

http://www.levenez.com/unix/
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UNIX

Commercial 
UNIX
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The commercial "UNIX" descendants

102

Sun Solaris
Servers and workstations

IBM AIX
Servers, mainframes and 
workstations

SCO UNIX
PC servers

HP HP-UX
Servers and workstations

Apple OS X
Mac computers

The UNIX trademark is owned and managed by The Open Group on behalf of the industry 
to signify products that are certified to conform to the Single UNIX Specification.
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BSD
Berkeley 
Software 

Distribution
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BSD Unix and its "UNIX-like" Descendants

Apple iOS
The Apple iOS, internally known as Darwin, 
like Mac OS X, runs on a Unix-like kernel 
(Mach kernel + BSD components)

Sources: http://en.wikipedia.org/wiki/Darwin_(operating_system)
http://en.wikipedia.org/wiki/IOS_(Apple)

Because the original BSD Unix was based on ATT's UNIX code it had to 
be re-written from scratch so it could be distributed freely as open 
source.  These "UNIX-like" descendants are not allowed to used the 
UNIX trademark. 

Source: http://en.wikipedia.org/wiki/OpenBSD

UC Berkeley had a source license from AT&T so they could make their own modifications 
and additions like TCP/IP which enabled Unix for the Internet.  BSD Unix was very popular 
with university and government users.
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GNU/Linux

GNU is Not Unix
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Kernel

GNU/Linux

Richard Stallman started the GNU project 

in 1983 to create a free UNIX-like OS.  

He founded the Free Software 

Foundation in 1985. In 1989 he wrote the 

first version of the GNU General Public 

License

Linus Torvalds, as a student, initially 

conceived and assembled the Linux kernel 

in 1991. The kernel was later re-licensed 

under the GNU General Public License in 

1992.

106

Shells

System commands

Utilities

Libraries

Much more …

http://en.wikipedia.org/wiki/Image:Heckert_GNU_white.svg
http://en.wikipedia.org/wiki/Image:Linus_Torvalds.jpeg
http://en.wikipedia.org/wiki/Image:Portrait_-_Denmark_DTU_2007-3-31.jpg
http://en.wikipedia.org/wiki/Image:Tux.svg
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OpenSUSERed Hat Enterprise Linux Fedora

Ubuntu

CentOS

Debian

Various GNU/Linux "Distros" (Distributions)

Note:  A distribution is built by a company or 
organization.  They start with the Linux kernel 
then add a custom mix of open source components.  
They may then add some of their own unique 
software to differentiate their distribution.  

107

Tux, the penguin, 
is the Linux kernel 
mascot

MageiaMint

http://en.wikipedia.org/wiki/Image:Tux.svg
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http://iso.linuxquestions.org/

108

There are hundreds of Linux distributions.  The one thing they 
have in common is they all use the Linux kernel.

Aug 28, 2018

15 Most Popular Linux Distro Downloads

http://iso.linuxquestions.org/
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Embedded Linux
(just a few)

109

Tivo QNAP
NAS storage

MikroTik
Routers

Android Tablets

Android
Cell Phones

Virgin America
Personal

Entertainment

Asus RT-AC66U 
wireless router

Katana
Robotic Arm

Garmin
Nuvi 5000

Yamaha Disklavier
Mark IV

Raspberry Pi

Some TomTom
GPS models

Sony TVs

For more see:

TripBPX
Phone 
System

Erle-Copter
drone

Stir smart desk

Polycom 
VOIP
Phone

Amazon
Kindle

Nest Cam

http://linuxgizmos.com/category/devices/

http://linuxgizmos.com/category/devices/
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Unix/Linux
Architecture
simplified

110
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UNIX/Linux Architecture
Simplified View

Kernel
(low level operating system functions)

Shell
(user interface and a programming language)

ApplicationsSystem Commands

111

Hardware

Users

Software



CIS 90 - Lesson 1

Architecture Dependent

Kernel Code 

Kernel

Space

Process

Management

Memory

Management
Network 

Stack

Virtual 

File System

User

Space 

Device Drivers 

Kernel1

Hardware

System Call Interface

Users

Commands & Utilities

Shell

X / Desktops

(multi-user)

GNU C Library (glibc)

Programs (multi-tasking)

Add-ons

1See “Anatomy of the Linux kernel” by M. Tim Jones at http://www-128.ibm.com/developerworks/linux/library/l-linux-kernel/

GNU/Linux Operating System Architecture

Richard Stallman started 

the GNU project in 1983 

to create a free UNIX-

like OS.  He Founded 

the Free Software 

Foundation in 1985. In 

1989 he wrote the first 

version of the GNU 

General Public License

Linus Torvalds, as a 

student, initially 

conceived and 

assembled the Linux 

kernel in 1991. The 

kernel was later re-

licensed under the GNU 

General Public License 

in 1992.

112

http://en.wikipedia.org/wiki/Image:Tux.svg
http://en.wikipedia.org/wiki/Image:Heckert_GNU_white.svg
http://en.wikipedia.org/wiki/Image:Linus_Torvalds.jpeg
http://en.wikipedia.org/wiki/Image:Portrait_-_Denmark_DTU_2007-3-31.jpg
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UNIX/Linux Design “Observations”

• Multi-tasking and multi-user capabilities

• Unlike Windows, the GUI does not run in the kernel (adds stability)

• Unlike Windows, multiple graphical desktops available 

• Linux kernel is “monolithic”, not a modular “microkernel”

• Dynamic - can load and unload modules on the fly

• Programs restricted to the privileges of the user running them 

(more secure)

• Scalable - scales up to handle the largest enterprise and mission-

critical applications

• Portable - runs on a variety of hardware platforms

• Reliable and robust

• Powerful, but NOT friendly !! 113
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Unix/Linux
Architecture
simplified

supplemental 114
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The Shell
(Command Line)

Kernel

Shell

Applications
System 

Commands

• Allows users to interact with the computer

• Called a “shell” because it hides the 
underlying operating system.

• Prompts user for a command, parses the 
command, then locates the command (a 
program or script) and runs it.

• Many shell programs are available: 
sh (Bourne shell), bash (Bourne Again 
shell), csh (C shell), ksh (Korn shell). 

• The shell is a user interface and a 
programming language (scripts).

• GNOME and KDE desktops could be called 
graphical shells.

115



CIS 90 - Lesson 1

The Shell Continued

Kernel

Shell

Applications
System 

Commands

116
The shell is a user interface and a programming language
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Various types of user interfaces

Graphic shells or 
desktops (GUI)

Shell Command Line Interface (CLI)

gnome

bash

Kernel

Shell

Applications
System 

Commands

117

Text User Interface (TUI)

Lokkit Utility (uses curses library)
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System Commands

Kernel

Shell

Applications
System 

Commands

• 100’s of system commands and  
utilities.

• We will learn how to use the following 
commands in this lesson:

▪ cal
▪ clear
▪ date
▪ exit
▪ hostname
▪ id
▪ ps
▪ ssh
▪ tty
▪ uname

118



CIS 90 - Lesson 1

UNIX/Linux Architecture
Applications

Kernel

Shell

Applications
System 

Commands

• Could be included in the distribution or 
optionally installed.

• Could be an add-on program developed 
by an ISV (Independent Software 
Vendor) or Open Source organization.

• Could be an in-house developed 
custom application.

• Examples are Apache (web server), 
GIMP (GNU image manipulation 
program), OpenOffice (word 
processing, spreadsheets, 
presentations), Oracle (commercial 
database), … etc.

119
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The Kernel

Kernel

Shell

Applications
System 

Commands

• Lowest level, inner-most core of the 
operating system.

➢ Process management - what 
programs are called when they are 
loaded and running.

➢ Memory management - handles all 
the reads and writes to memory 
(RAM and virtual memory).

➢ File System - handle all the reads 
and writes to files on drives.

➢ Network stack - provides the 
communication layers to exchange 
packets with other computers.

120
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Market 
Share
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Market Share

Supplemental
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Worldwide Server Market

Source: Jorge Vela at IDC 

124

Source: IDC, https://www.idc.com/getdoc.jsp?containerId=prUS41424716
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Website hits by browser OS

1-This report was generated 07/31/2010 based on the last 15,000 page views to each website tracked by W3Counter. W3Counter's sample currently 
includes 38,996 websites. The browser market share graph includes data from all versions of the named browser families, not only the top 10 as 
listed below.

2-This report was generated 01/31/2013 based on the last 15,000 page views to each website tracked by W3Counter. W3Counter's sample currently 
includes 63,187 websites. The browser market share graph includes data from all versions of the named browser families, not only the top 10 as 
listed below.

3-This report was generated 07/31/2018 based on the past month's traffic to all websites that use W3Counter's free web stats.

125

Source:

Jan 20132

22.8% 62.8%

Jul 20183Jul 20101

6.9%

http://www.w3counter.com/globalstats.php

http://www.w3counter.com/
http://www.w3counter.com/globalstats.php
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Kali Linux (Iceweasel)

Mac OS X 10.12 (Safari)

Windows 10 (Edge)

When you surf 
websites you 
leave 
information such 
as your IP 
address, 
operating 
system and 
browser app. 

How does the W3counter count Operating Systems?  Browsers provide the information. 
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Source:

Smartphones

https://www.gartner.com/en/newsroom/press-releases/2018-
08-28-gartner-says-huawei-secured-no-2-worldwide-
smartphone-vendor-spot-surpassing-apple-in-second-quarter

https://www.gartner.com/en/newsroom/press-releases/2018-08-28-gartner-says-huawei-secured-no-2-worldwide-smartphone-vendor-spot-surpassing-apple-in-second-quarter
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128Source:

Linux dominates 
the Supercomputer 
market

Fujitsu K 
computer in 
Japan

Sequoia, IBM 
BlueGene/Q 
at Lawrence 
Livermore 
Lab

Operating System Share June 2017

Tianhe-2 
supercomputer 
in China

Cray XK7 
Titan at Oak 
Ridge National 
Lab

Mira, IBM 
BlueGene/Q 
at Argonne 
Lab

http://www.top500.org/statistics/list/

http://www.top500.org/statistics/list/
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Logging in  
via ssh
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SSH
(secure shell)

Getting the car keys
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Telnet uses clear text SSH is encrypted

Remote Server

Old way: telnet
Sniffer view of a Telnet session

New way: ssh
Sniffer view of a SSH session

With telnet, everything is  
transferred in clear text over 
the network (not good!)

With ssh, everything is encrypted.  
This is how we will access all 
UNIX/Linux systems in CIS 90.

131

Solution: SSH is a network 
protocol that enables 
secure connections 
between computers

Picture credit: http://www.cs.umd.edu/faq/ssh.html

Problem: We need a secure 
(encrypted) way to login 
and enter commands to a 
remote server over the 
network.

username

password

cat secret

exit

Local computer at home or on campus

Opus-II Server
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SSH (secure shell) is a standards based protocol.  We will 

use it for remotely logging into and running commands on 

UNIX/Linux systems.

• See RFCs 4250 to 4254 at www.ietf.org 

for the gory details

• “RFC” = Request for Comment

• “IETF” = Internet Engineering Task Force

132
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An SSH app may need to be installed

✓ Linux and Mac already have SSH built in (i.e. the ssh command)

❑ Android smartphones and tablets can use SSH apps such as the free 

ConnectBot or Juice apps (I like Juice best)

❑ Apple iPhones and iPads can use ssh apps such as the iSSH app

❑ Windows users can download and install the Putty program

133

Putty is written and maintained primarily by Simon Tatham.
http://www.chiark.greenend.org.uk/~sgtatham/
Thank you Simon!
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Opening Putty on a Windows PC
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Opening a terminal on an Apple Mac
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Class Activity – Install SSH software if necessary

Operating 
System

Students in 
the classroom

Students 
at home

Windows

• Find and run the Putty 
program

• Google “putty download” 
• Download the putty.exe binary 

to your desktop
• Run the downloaded putty.exe 

program

Linux or Mac

• Search for and run the 
terminal app

http://www.chiark.greenend.org.uk/~
sgtatham/putty/download.html

http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html
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First
Login
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Get into 
the car

138
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SSH connection to a UNIX/Linux Server

139

To connect and login to a remote system you must know:

• The hostname or IP Address of the remote server (hostnames 

must be fully qualified domain names when going over the 

Internet)

• The port number the SSH service is listening on (the default for 

SSH is port 22)

• Your login credentials (username and password) on the remote 

server 
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1) You need an address to find someone's home on a map.

2) When you get there some doors are open and some are 
closed. You can only enter if the door is open.

3) Authentication is required for access:
Homer owner: Who the heck are you?
Visitor: My name is Rich and I live next door in the small shack

1) You need an IP address or hostname to 
find a server on the Internet.

http://modernwarpoetry.com/wp-content/uploads/2014/09/Vertical-Siding-Brick-wall-white-house-with-a-big-house.jpg

2) When you get there some ports
are open and some are closed. You 
can only connect if the port is open.

3) Authentication is required for access:
Server: Enter username & password
Visiting user: rsimms & <secret>

http://product-images.www8-hp.com/digmedialib/prodimg/lowres/c03120597.png

How people access a home somewhere 

How users access a server somewhere

PORT   STATE  SERVICE

21/tcp closed ftp

22/tcp open   ssh

23/tcp closed telnet

25/tcp open   smtp

80/tcp open   http
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Logging into the Opus-II server
(The Linux server we primarily use for this course)

141

• The hostname is: opus-ii.cis.cabrillo.edu

• The port is: 2220

• You must use your own username and password credentials

You will need your unique login credentials for this module. To get 
them see my "Welcome to CISA 90" announcement in Canvas. 
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Login 
Credentials

Usernames and passwords

142
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Instructor Note:

PAUSE Recording,
Switch to credentials 

document
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The Login Credentials slides are not
included in these lesson slides. 

To locate a copy, login into Canvas and 
read my Welcome to CIS 90 

announcement.
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Instructor Note:

RESUME Recording,
continue with lesson 

slides
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Opus-II

On Windows run Putty

opus-ii.cis.cabrillo.edu 2220

The first time a 
connection is made 
to a server this 
authenticity warning 
is displayed.

Click Open

Click Yes

SSH connection to a UNIX/Linux Server

(From Windows using Putty)
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Note: If you specified the username in Putty or on the ssh 
command you will not be prompted for the username again.

Enter username
(if prompted)

Enter password
(not echoed)

Enter exit command to 
end session

Hit Enter to accept 
default terminal type

Use your own 
username, 
not Benji's!

SSH connection to a UNIX/Linux Server

(From Windows using Putty)
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Opus-II

Enter yes if you get 
this authenticity 
warning on the first 
connection.

SSH connection to a UNIX/Linux Server

(From Linux or Mac using a terminal)

On a Mac or Linux terminal type:

ssh -p 2220  username@opus-ii.cis.cabrillo.edu

The authenticity of host '[opus-ii.cis.cabrillo.edu]:2220 

([2607:f380:80f:f425::244]:2220)' can't be established.

RSA key fingerprint is 00:51:a2:ca:8a:08:30:9c:09:2e:e4:8a:bb:1f:94:b1.

Are you sure you want to continue connecting (yes/no)? yes

An RSA fingerprint is a 
cryptographic hash of the 
server's public key.

Login continued on next slide
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SSH connection to a UNIX/Linux Server - from Linux or Mac

Enter password
(not echoed)

Enter exit command to 
end session

Hit Enter/Return to 
accept default 
terminal type
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Class Activity
Log into Opus-II using SSH

(specify hostname, username, password, and port)

1) On Windows run Putty:

opus-ii.cis.cabrillo.edu 2220

1) On a Mac or Linux terminal type:
ssh -p 2220  username@opus-ii.cis.cabrillo.edu

Respond "yes" to 
authenticity warning if 

it appears

2) Enter your credentials (not Benji's)
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Additional Resources

• How to open the terminal window on a mac 

• Howto #146: Logging into Opus-II 

https://www.youtube.com/watch?v=zw7Nd67_aFw

https://simms-teach.com/howtos/146-opus-access.pdf

https://www.youtube.com/watch?v=zw7Nd67_aFw
https://simms-teach.com/howtos/146-opus-access.pdf


CIS 90 - Lesson 1

152

First
Commands
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First driving 
lesson

153
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Lesson 1 commands for your toolbox

cal - show calendar
date - show current time and date
clear - clear the terminal screen

hostname - show the host name of the computer being accessed
ps - show processes, including the name of the shell being run
uname - show the kernel name
cat /etc/issue - usually shows distro (distribution) name
cat /etc/*-release - usually shows distro (distribution) name

who - shows current login sessions
who am i - identifies which login session you are using
tty - shows your terminal device
id - show user info including username/UID and group/GID

history - show previous commands

ssh - Connect and login to remote system
exit - terminate your shell and log off
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login as: simben90

simben90@oslab.cabrillo.edu's password:

Last login: Sat Aug 19 11:02:46 2017 from oslab.cis.cabrillo.edu

_

('v')

\/-=-\/

(\_=_/)

~~ ~~

Welcome to Opus II

Serving Cabrillo College

Terminal type? [xterm]

Terminal type is xterm.

/home/cis90/simben $ 

Terminal type

Hit Enter key here to accept 
default terminal type

The terminal type in this case is "xterm".  The terminal type is different 
than the terminal device (more on this later).
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login as: simben90

simben90@oslab.cabrillo.edu's password:

Last login: Sat Aug 19 11:02:46 2017 from oslab.cis.cabrillo.edu

_

('v')

\/-=-\/

(\_=_/)

~~ ~~

Welcome to Opus II

Serving Cabrillo College

Terminal type? [xterm]

Terminal type is xterm.

/home/cis90/simben $ 

/home/cis90/simben $

Shell Prompt

Shell prompt - used by the shell to prompt the 
user to enter a command.  The shell will display 
this prompt every time you hit the Enter key.

Hit Enter key here to accept 
default terminal type

Question:  What is your exact prompt string on this system?
Answer: /home/cis90/simben $
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First
Commands

supplemental

examples
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/home/cis90/simben $ cal

August 2017

Su Mo Tu We Th Fr Sa

1  2  3  4  5

6  7  8  9 10 11 12

13 14 15 16 17 18 19

20 21 22 23 24 25 26

27 28 29 30 31

The cal command outputs the 
calendar for the current month.

cal command

prompt command
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/home/cis90/simben $ cal 12 2012

December 2012

Su Mo Tu We Th Fr Sa

1

2  3  4  5  6  7  8

9 10 11 12 13 14 15

16 17 18 19 20 21 22

23 24 25 26 27 28 29

30 31

Adding the month and year 
arguments to the cal command lets 
you specify a specific month and year

cal command continued

Question:  What day of the week (e.g Su Mo, Tu ...) was December 25, 2012?
Answer: Tu

prompt
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/home/cis90/simben $ date

Tue Aug 26 08:11:31 PDT 2014

The date command outputs the current 
date and time.

date command

Question:  What time is it on this system? (use HH:MM format and don't dawdle!)
Answer: 08:11

prompt

Day-of-the-week  Month  Day-of-the-month  Hours:Minutes:Seconds Time-Zone  Year
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/home/cis90/simben $ cal 12 2012

December 2012

Su Mo Tu We Th Fr Sa

1

2  3  4  5  6  7  8

9 10 11 12 13 14 15

16 17 18 19 20 21 22

23 24 25 26 27 28 29

30 31

Command Line Interface (CLI) terminology

/home/cis90/simben $ cal 12 2012

December 2012

Su Mo Tu We Th Fr Sa

1

2  3  4  5  6  7  8

9 10 11 12 13 14 15

16 17 18 19 20 21 22

23 24 25 26 27 28 29

30 31

/home/cis90/simben $ cal 12 2012

December 2012

Su Mo Tu We Th Fr Sa

1

2  3  4  5  6  7  8

9 10 11 12 13 14 15

16 17 18 19 20 21 22

23 24 25 26 27 28 29

30 31

This portion is the shell prompt

This is the command
which includes two 
arguments 12 and 2012

This is the output of 
the command

These are arguments for 
the command to process
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/home/cis90/simben $ clear

The clear command will clear the screen.  

(On scrollable terminals you are still able to 
scroll back to see previous commands entered)

clear command

prompt

Question: What happens when you use the clear command?
Answer: The terminal window is cleared (scrolled up and out of sight)

before after
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/home/cis90/simben $ hostname

opus-ii.cis.cabrillo.edu

hostname command

The hostname command outputs the 
hostname of the system you are 
interacting with.

prompt command

Question:  What is the hostname of this system?
Answer: opus-ii.cis.cabrillo.edu
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/home/cis90/simben $ ps

PID TTY          TIME CMD

21629 pts/0    00:00:00 bash

21674 pts/0    00:00:00 ps

ps command

The ps command outputs the processes 
(programs loaded into memory and 
running) belonging to your username.

name of the 
shell being run

prompt

There are a number of differnet shells such as bash (Bourne 
Again shell), sh (original Bourne shell), ksh (Korn shell), dash
(Debian Almquist shell), tcsh (TENEX C Shell) and csh (C shell).

Question:  What is the name of the shell running on this system?
Answer: bash

name of the ps command running 
that produces this output



CIS 90 - Lesson 1

165

/home/cis90/simben $ uname

Linux

uname command

The uname command outputs the 
name of the kernel being used.  

Question:  What is the name of the kernel running on this system?
Answer: Linux
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cat command (to show the name of the distribution)

These two cat commands will 
usually (but not always) output 
something that contains the 
name of the distribution being 
used.  

/home/cis90/simben $ cat /etc/issue

\S

Kernel \r on an \m

Question:  Which distro has been installed on this system? (single word answer please)
Answer: CentOS

/home/cis90/simben $ cat /etc/*-release

CentOS Linux release 7.3.1611 (Core)

NAME="CentOS Linux"

VERSION="7 (Core)"

ID="centos"

ID_LIKE="rhel fedora"

VERSION_ID="7"

PRETTY_NAME="CentOS Linux 7 (Core)"

ANSI_COLOR="0;31"

CPE_NAME="cpe:/o:centos:centos:7"

HOME_URL="https://www.centos.org/"

BUG_REPORT_URL="https://bugs.centos.org/"

CENTOS_MANTISBT_PROJECT="CentOS-7"

CENTOS_MANTISBT_PROJECT_VERSION="7"

REDHAT_SUPPORT_PRODUCT="centos"

REDHAT_SUPPORT_PRODUCT_VERSION="7"

CentOS Linux release 7.3.1611 (Core)

CentOS Linux release 7.3.1611 (Core)
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cat command (to show the name of the distribution)

These two cat commands will 
usually (but not always) output 
something that contains the 
name of the distribution being 
used.  

Question:  Which distro has been installed on this system?  (single word answer please)
Answer: Ubuntu

simben90@doc:~$ cat /etc/*-release

DISTRIB_ID=Ubuntu

DISTRIB_RELEASE=13.04

DISTRIB_CODENAME=raring

DISTRIB_DESCRIPTION="Ubuntu 13.04"

NAME="Ubuntu"

VERSION="13.04, Raring Ringtail"

ID=ubuntu

ID_LIKE=debian

PRETTY_NAME="Ubuntu 13.04"

VERSION_ID="13.04"

HOME_URL="http://www.ubuntu.com/"

SUPPORT_URL="http://help.ubuntu.com/"

BUG_REPORT_URL="http://bugs.launchpad.net/ubuntu/"

simben90@doc:~$ cat /etc/issue

Ubuntu 13.04 \n \l
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who command

username terminal 
device 
used for 
login 
session

date and time 
of login

where user logged in from (remote hostname 
or IP address) .  If empty the user logged on 
locally rather than over the network.

Show information about current login sessions

/home/cis90/simben $ who

root     tty1         2014-08-13 17:07

root     tty2         2014-08-13 17:07

rsimms pts/0        2014-08-12 18:10 (2601:9:6680:53b:1918:aee5:1785:79f4)

simben90 pts/1        2014-08-13 16:39 (2601:9:6680:53b:1918:aee5:1785:79f4)

simben90 pts/2        2014-08-12 10:41 (2601:9:6680:53b:edf7:ab23:af8b:7b73)

milhom90 pts/3        2014-08-13 16:39 (2601:9:6680:53b:1918:aee5:1785:79f4)

rsimms pts/4        2014-08-13 16:40 (ec2-54-193-87-225.us-west-1.compute.amazonaws.com)
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who command

/home/cis90/simben $ who

root     tty1         2014-08-13 17:07

root     tty2         2014-08-13 17:07

rsimms pts/0        2014-08-12 18:10 (2601:9:6680:53b:1918:aee5:1785:79f4)

simben90 pts/1        2014-08-13 16:39 (2601:9:6680:53b:1918:aee5:1785:79f4)

simben90 pts/2        2014-08-12 10:41 (2601:9:6680:53b:edf7:ab23:af8b:7b73)

milhom90 pts/3        2014-08-13 16:39 (2601:9:6680:53b:1918:aee5:1785:79f4)

rsimms pts/4        2014-08-13 16:40 (ec2-54-193-87-225.us-west-1.compute.amazonaws.com)

local

remote

Users in the same room as the system can login locally.  Everyone 
else must login remotely over the network.  The IP address or 
hostname in the last column indicates a remote login session.



CIS 90 - Lesson 1

170

who command

Question:  How many login sessions (including yours) are there on this system?
Answer: 7

Question:  Regarding the users logged in REMOTELY (over the network rather 
than local). Who has been logged in the longest?
Answer: simben90

Question:  Where did that REMOTE user (the one logged in longest) login from?
Answer: 2601:9:6680:53b:edf7:ab23:af8b:7b73 (this is an IPv6 address)

/home/cis90/simben $ who

root     tty1         2014-08-13 17:07

root     tty2         2014-08-13 17:07

rsimms pts/0        2014-08-12 18:10 (2601:9:6680:53b:1918:aee5:1785:79f4)

simben90 pts/1        2014-08-13 16:39 (2601:9:6680:53b:1918:aee5:1785:79f4)

simben90 pts/2        2014-08-12 10:41 (2601:9:6680:53b:edf7:ab23:af8b:7b73)

milhom90 pts/3        2014-08-13 16:39 (2601:9:6680:53b:1918:aee5:1785:79f4)

rsimms pts/4        2014-08-13 16:40 (ec2-54-193-87-225.us-west-1.compute.amazonaws.com)
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/home/cis90/simben $ who am i

simben90 pts/1        2014-08-13 16:39 (2601:9:6680:53b:1918:aee5:1785:79f4)

who am i command

This is a good way to distinguish which session you are currently interacting 
with when you have logged in more than once on the same system.

username terminal 
device used 
for login 
session

date and time of 
login

The who am i command lists just the session you are using

where user logged in from (remote hostname 
or IP address) .  If empty the user logged on 
locally rather than over the network.
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/home/cis90/simben $ tty

/dev/pts/0

tty command

The tty command shows the terminal 
device being used for the login session. 

Every login session uses a unique 
terminal device.

The terminal device is different than the 
terminal type you accepted during 
login.

Question:  Which terminal device are you using to connect to this system?
Answer: /dev/pts/0
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tty command

The terminal device is abbreviated in who output.  The tty
command on the other hand shows the entire terminal device.

Question:  Run the who am i and tty commands.
What portion of the output from these commands is identical?

Answer: pts/1

/home/cis90/simben $ who am i

simben90 pts/1        2014-08-13 16:39 (2601:9:6680:53b:1918:aee5:1785:79f4)

/home/cis90/simben $

/home/cis90/simben $

/home/cis90/simben $ tty

/dev/pts/1
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id command

The id command outputs information about the user 

Question:  What is your uid (user ID) number on oslab?
Answer: 1201

Question:  What is your gid (group ID) number on oslab?
Answer: 190

Question:  What is your username on oslab?
Answer: simben90

/home/cis90/simben $ id

uid=1201(simben90) gid=190(cis90) groups=190(cis90),100(users) 

context=unconfined_u:unconfined_r:unconfined_t:s0-s0:c0.c1023
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/home/cis90/simben $ history

< snipped>
54  cal

55  cal 12 2012

56  date

57  clear

58  hostname

59  ps

60  uname

61  cat /etc/issue

62  cat /etc/*-release

63  who

64  who am i

65  tty

66  id

67  id milhome90

68  id milhom90

69  id rsimms

70  history

The history command shows all 
previously entered commands.  

The list can span multiple login 
sessions.

history command

Question:  What happens when you use the history command?
Answer: Shows previously entered commands
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Basic command syntax:

ssh -p nnnn username@hostname

ssh command
(to securely log into a remote UNIX/Linux system)

Optional.  Specifies  the account 
username on the remote 

system.  The default is the 
username on the local system.

Required. This can be the 
hostname or IP address of the 
remote system.  If a hostname is 
used for a server on the Internet 
it must be the entire fully 
qualified domain name (FQDN).

Optional. Specifies the port 
on the remote system.  The 

default is port 22.

If a username is specified the "@" 
is used to separate the username 
from the hostname.
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/home/cis90/simben $ ssh cis90@arya-03

The authenticity of host 'arya-03 (172.20.90.3)' can't be established.

RSA key fingerprint is 8b:a0:ef:d2:52:e4:f3:a3:c2:41:b5:93:89:c3:1d:58.

Are you sure you want to continue connecting (yes/no)? yes

Warning: Permanently added 'arya-03,172.20.90.3' (RSA) to the list of known 

hosts.

cis90@arya-03's password:

Welcome to Linux Mint 15 Olivia (GNU/Linux 3.8.0-26-generic x86_64)

Welcome to Linux Mint

* Documentation:  http://www.linuxmint.com

Last login: Mon Jan 27 17:13:33 2014 from opus.cis.cabrillo.edu

cis90@arya-03:~ > exit

logout

Connection to arya-03 closed.

/home/cis90/simben $

Example ssh command
Logging into a Arya-xx system from Opus-II

username short hostname

password is typed but not echoed

Note how the prompt changes (highlighted above) when on a different system
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Example ssh command
Logging into son-of-opus from Opus-II

Note how the prompt changes (highlighted above) when on different systems

/home/cis90/simben $ ssh -p 2220 simben90@son-of-opus.simms-teach.com

simben90@son-of-opus.simms-teach.com's password:

Last login: Mon Jan 27 18:14:32 2014 from oslab.cis.cabrillo.edu

_

('v')

//-=-\\

(\_=_/)

~~ ~~

Welcome to Son of Opus

Serving Cabrillo College

[simben90@son-of-opus ~]$ exit

logout

Connection to son-of-opus.simms-teach.com closed.

/home/cis90/simben $

username FQDN hostname

password is typed

non-standard ssh port
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/home/cis90/simben $ exit The exit command logs out and 
ends the session.  

exit command
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• Google the topic/error message.

• Search the Lesson Slides (they are PDFs) for a relevant example on how to 
do something.

• Check the forum.  Someone else may have run into the same issue and 
found a way past it. If not start a new topic, explain what you are trying to 
do and what you have tried so far.

• Talk to a tutor/assistant at the CTC (room 1403) or CIS Lab (STEM Center).

• Come see me during my office or lab hours:

I'm in the CTC (room 1403) every Tuesday from 3:30-6:00 pm.

• Make use of the Open Questions time at the start of every class. 

• Make a cheat sheet of commands and examples so you never again get 
stuck on the same thing! 

CIS Labs always involve some troubleshooting!

https://www.cabrillo.edu/salsa/listing.php?staffId=1426

https://www.cabrillo.edu/salsa/listing.php?staffId=1426
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Instructors, tutors 
and equipment are 
available for CIS 
students to work on 
assignments.

Help Available!
In the CTC and CIS Lab

To see tutor 
schedule, click 
the Tutors link 

on the 
website.

CIS Lab
in STEM Center
Building 800

CTC
Room 1403
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Help Available!
In the CTC and CIS Lab

The CIS Lab is in the STEM 
center (Building 800)

Room 1403 is in the 
CTC (Building 1400)

To see tutor schedule, click the 
Tutors link on the website.
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• Available after class (stop by or email me).

• Please use them online ASAP!

• If you missed the first class, obtaining an Add code will be 

conditional on catching up before the next class:

a) making a forum post.

b) answering one of the "first minute" quiz questions.

c) submitting the survey (part of the first assignment).

d) collecting at least one item on the scavenger hunt.

184

Add Codes
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Subscribe by sending an email (no subject or body) to:

networkers-subscribe@cabrillo.edu

• Program information

• Certification information

• Career and job information

• Short-term classes, events, lectures, tours, etc.

• Surveys

• Networking info and links

Cabrillo Networking Program Mailing list

186
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Computer Science and Computer Information Systems 

at Cabrillo College
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https://www.linkedin.com/groups/6689142

For 3 points extra credit:

1) Join LinkedIn.com
2) Join this group 
3) Send me an email when 

finished.

https://www.linkedin.com/groups/6689142
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How to obtain Microsoft 
and VMware software 
for academic use

Software for eligible CIS students

https://simms-teach.com/resources.php

https://simms-teach.com/resources.php
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Microsoft software for students 
registered in a CIS or CS class at 
Cabrillo.

Available after registration is final 
(two weeks after first class).

For convenience, links to the 
Academic webstores are on the 
Resource page of the website:

Licensed for educational use only.

Happy downloading!

https://simms-teach.com/resources.php

Microsoft Academic Webstore

https://simms-teach.com/resources.php
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VMware software for students 
registered in a CIS or CS class at 
Cabrillo.

Available after registration is final 
(two weeks after first class).

For convenience, links to the 
Academic webstores are on the 
Resource page of the website:

Licensed for educational use only.

Happy downloading!

https://simms-teach.com/resources.php

https://simms-teach.com/resources.php
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• Two heads are better than one!

• Great way to work lab assignments and prepare for tests.

• Excellent way to learn.

• Less time being in the "I'm stuck" zone.

• A great way to develop teamwork skills.

• Improves scheduling and organization skills.

• Let me know on the student survey if you are interested and 
would like my help finding study partners.
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Navigating the 
Internet using 

SSH

Second driving lesson
193
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CIS 90 
systems 
Roadmap

194
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son-of-opus.simms-teach.com

AWS (Oregon, public)

Your home (private)

Defiant (2221)

Intrepid (2224)

Enterprise (2223)

Freedom (2225)

Excalibur (2226)

Lexington (2222)

Sun-Hwa-xx
Arya-xx's
Home-ZeroW

Opus-II.cis.cabrillo.edu

uLab devices
Room 828 PCs
Room 829 PCs
Room 830 PCs

195

CIS Lab and Classroom networks 
(Aptos, private)

CIS Server network (Aptos, public)

brienne.simms-teach.com

baby-opus

(Soquel, private)

simms-teach.com

DreamHost
(Los Angeles, public)

Internet

daughter-of-opus.simms-teach.com

OVH (Montreal, public)

2220

2220

2225

2220

You cannot access 
servers with private IP 
addresses directly 
from the Internet.

Instead you must 
enter via server with a 
public address that is 
also connected to the 
private network.
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Raspberry Pi Zero W

https://www.adafruit.com/products/3400

https://www.adafruit.com/products/3400
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To see which Arya VM is yours use the link on 
the class website

http://simms-teach.com/

http://simms-teach.com/
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Follow me if you can!

Class Activity

You cannot access 
servers with private IP 
addresses directly 
from the Internet.

Instead you must 
enter via server with a 
public address that is 
also connected to the 
private network.

Start 
here
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Navigating the 
Internet using 

SSH

supplemental
199
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Opus-II 
(Aptos)

Defiant
(Aptos)

Son-of-Opus
(Amazon Northern 

CA Cloud)

Brienne
(Soquel)

Giles
(Los Angeles)

Home
(Soquel)

Benji takes on a long walk

1

2

3

4

5

6

7

8

9

10

Putty or ssh -p 2220 simben90@opus-ii.cis.cabrillo.edu 

ssh -p 2221 simben90@defiant.cis.cabrillo.edu

ssh -p 2222 simben90@brienne.simms-teach.com

ssh -p 2220 simben90@son-of-opus.simms-teach.com

ssh simben90@giles.dreamhost.com

exit

exit

exit

exit

exit

1

2

3

4

5

6

7

8

9

10

Note:  hostnames are not case 
sensitive (any portion can be 
upper or lower case)
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Opus-II
(Aptos)

Benji takes on a long walk

1

login as: simben90

simben90@opus-ii.cis.cabrillo.edu's password:

Last login: Sat Aug 19 11:02:46 2017 from oslab.cis.cabrillo.edu

_

('v')

\/-=-\/

(\_=_/)

~~ ~~

Welcome to Opus II

Serving Cabrillo College

Terminal type? [xterm]

Terminal type is xterm.

/home/cis90/simben $ hostname

oslab.cis.cabrillo.edu

/home/cis90/simben $

Note:  usernames and 
passwords are case sensitive

simben90@opus-ii.cis.cabrillo.edu

simben90@opus-ii.cis.cabrillo.edu
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Opus-II 
(Aptos)

Defiant
(Aptos)

Benji takes on a long walk

2

/home/cis90/simben $ ssh -p 2221 simben90@defiant.cis.cabrillo.edu

The authenticity of host '[defiant.cis.cabrillo.edu]:2221 ([172.20.90.51]:2221)' can't 

be established.

RSA key fingerprint is 98:09:e7:d3:b2:89:e5:3a:57:b0:59:ff:86:7e:8e:50.

Are you sure you want to continue connecting (yes/no)? yes

Warning: Permanently added '[defiant.cis.cabrillo.edu]:2221' (RSA) to the list of known 

hosts.

simben90@defiant.cis.cabrillo.edu's password:

Welcome to Linux Mint 17 Qiana (GNU/Linux 3.13.0-24-generic x86_64)

Welcome to Linux Mint

* Documentation:  http://www.linuxmint.com

________          _____.__               __

\______ \ _____/ ____\__|____    _____/  |_

|    |  \_/ __ \ __\|  \__  \ /    \ __\

|    `   \ ___/|  |  |  |/ __ \|   |  \ |

/_______  /\___  >__|  |__(____  /___|  /__|

\/     \/              \/     \/

Last login: Fri Aug 15 07:07:25 2014 from opus-ii.cis.cabrillo.edu

[defiant] $ hostname

defiant.cis.cabrillo.edu

[defiant] $
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Benji takes on a long walk

[defiant] $ ssh -p 2222 simben90@brienne.simms-teach.com

The authenticity of host '[brienne.simms-teach.com]:2222 ([50.174.12.192]:2222)' can't be established.

ECDSA key fingerprint is 22:f1:74:fb:3c:36:01:8a:21:f0:00:e1:37:56:00:5f.

Are you sure you want to continue connecting (yes/no)? yes

Warning: Permanently added '[brienne.simms-teach.com]:2222,[50.174.12.192]:2222' (ECDSA) to the list of 

known hosts.

simben90@brienne.simms-teach.com's password:

Welcome to Linux Mint 17.2 Rafaela (GNU/Linux 3.16.0-38-generic x86_64)

Welcome to Linux Mint

* Documentation:  http://www.linuxmint.com

__________        .__

\______   \_______|__| ____   ____   ____   ____

|    |  _/\_  __ \ |/ __ \ /    \ /    \_/ __ \

|    |   \ |  | \/  \ ___/|   |  \ |  \ ___/

|______  / |__|  |__|\___  >___|  /___|  /\___  >

\/                \/     \/     \/     \/

simben90@brienne ~ $

Defiant
(Aptos)

3

Brienne
(Soquel)
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Benji takes on a long walk

[simben90@brienne ~]$ ssh -p 2220 simben90@son-of-opus.simms-teach.com

The authenticity of host '[son-of-opus.simms-teach.com]:2220 ([54.193.87.225]:2220)' can't 

be established.

RSA key fingerprint is 05:02:f7:48:00:e6:af:a9:dd:47:33:c3:82:80:29:4d.

Are you sure you want to continue connecting (yes/no)? yes

Warning: Permanently added '[son-of-opus.simms-teach.com]:2220,[54.193.87.225]:2220' (RSA) 

to the list of known hosts.

simben90@son-of-opus.simms-teach.com's password:

Permission denied, please try again.

simben90@son-of-opus.simms-teach.com's password:

Last login: Mon Aug 18 12:55:04 2014 from 207.62.187.227

_

('v')

//-=-\\

(\_=_/)

~~ ~~

Welcome to Son-of-Opus

Serving Cabrillo College

[simben90@son-of-opus ~]$

Son-of-Opus
(Amazon Northern 

CA Cloud)

Brienne
(Soquel)

4
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Benji takes on a long walk

[simben90@son-of-opus ~]$ ssh simben90@giles.dreamhost.com

The authenticity of host 'giles.dreamhost.com (208.113.153.233)' can't be established.

RSA key fingerprint is d8:3c:65:de:d3:43:ef:aa:76:13:d9:16:85:b9:36:9a.

Are you sure you want to continue connecting (yes/no)? yes

Warning: Permanently added 'giles.dreamhost.com,208.113.153.233' (RSA) to the list of known 

hosts.

simben90@giles.dreamhost.com's password:

_ _

__ _(_) | ___  ___

/ _` | | |/ _ \/ __|

| (_| | | |  __/\__ \

\__, |_|_|\___||___/

|___/

Welcome to giles.dreamhost.com

Any malicious and/or unauthorized activity is strictly forbidden.

All activity may be logged by DreamHost Web Hosting.

[giles]$ hostname

giles

Son-of-Opus
(Amazon Northern 

CA Cloud)

giles
(Los Angeles)

5
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Benji takes on a long walk

[giles]$ exit

logout

Connection to giles.dreamhost.com closed.

[simben90@son-of-opus ~]$ hostname

son-of-opus.simms-teach.com

[simben90@son-of-opus ~]$

Son-of-Opus
(Amazon Northern 

CA Cloud)

giles
(Los Angeles)

6

When you exit a server it's like you pop 
it off the top of a stack and return to the 
previous server underneath

giles
son-of-opus

brienne
defiant
opus-ii
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Benji takes on a long walk

[simben90@son-of-opus ~]$ exit

logout

Connection to son-of-opus.simms-teach.com closed.

[simben90@brienne ~]$ hostname

brienne.simms-teach.com

[simben90@brienne ~]$

Son-of-Opus
(Amazon Northern 

CA Cloud)

Brienne
(Soquel)

7

When you exit a server it's like you pop 
it off the top of a stack and return to the 
previous server underneath

son-of-opus
brienne
defiant
opus-ii
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Benji takes on a long walk

[simben90@brienne ~]$ exit

logout

Connection to brienne.simms-teach.com closed.

[defiant] $ hostname

defiant.cis.cabrillo.edu

[defiant] $

Defiant
(Aptos)

Brienne
(Soquel)

8

When you exit a server it's like you pop 
it off the top of a stack and return to the 
previous server underneathbrienne

defiant 
opus-ii
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Benji takes on a long walk

[defiant] $ exit

Connection to defiant.cis.cabrillo.edu closed.

/home/cis90/simben $ hostname

oslab.cis.cabrillo.edu

/home/cis90/simben $

Opus 
(Aptos)

Defiant
(Aptos)

9

When you exit a server it's like you pop 
it off the top of a stack and return to the 
previous server underneath

defiant
opus-ii 
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Benji takes on a long walk

/home/cis90/simben $ exit

Opus 
(Aptos)

Home
(Soquel)

10

And the Putty terminal program closes

When you exit a server it's like you pop 
it off the top of a stack and return to the 
previous server underneath

opus-ii 
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http://simms-teach.com/cis90calendar.php

2) Survey

3) Lab 1
Scavenger 
Hunt

Both deliverables are due by 11:59:59 PM 
(Opus-II time) on Wednesday 2/6.

Remember late work, even one second late, 
is not accepted.  If you wait till the last 
minute to work the lab and run out of time 
submit any partial work by the deadline.

Assigned on 1/30

1) Reading the Lesson slides first 
will help you with the lab
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Lexington

opus-ii.cis.cabrillo.edu
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Starting on Opus you will log into several systems using ssh. On each system 
you will collect an item after answering correctly a series of questions.  

Excalibur              

Enterprise                   Freedom                   

Intrepid                    
Defiant

Get a star

Get a movie Get a book

Get a fruit

Get a dog

Get a musical instrument

Lab 1 - Scavenger Hunt

Start and 
end here
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Your home network
(private)
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Internet

Defiant (2221)

Intrepid (2224)

Enterprise (2223)

Freedom (2225)

Excalibur (2226)

Lexington (2222)

Opus-II.cis.cabrillo.edu 2220

CIS Lab network (private)

Lab 1 - Simplified Network Map

The scavenger hunt systems are on a 
private network.  

Remote users must log into Opus-II first 
and from there access the scavenger hunt 
systems.

CIS server network (public)
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Tip  - as a shortcut, use sc instead of 
typing the full scavenge each time.

Lab 1 - Tips
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Tip - use two login sessions.  Use one to 
collect  scavenger hunt items and the 
other to record your work using the 
submit script. Submit as many times as 
you wish.  Only the last submittal will be 
graded.

Lab 1 - Tips

To paste in Putty just  
use a right mouse click 

To copy text in Putty just select 
it (left mouse button and drag) 

copy

paste
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Lab Assignments

Pearls of  Wisdom:

• Don't wait till the last minute to start.

• The slower you go the sooner you will be finished.

• A few minutes reading the forum can save you hour(s).

• Line up materials, references, equipment and software ahead of time.

• It's best if you fully understand each step as you do it.  Refer back to 
lesson slides to understand the commands you are using. 

• Use Google when trouble-shooting

• Keep a growing cheat sheet of commands and examples.

• Study groups are very productive and beneficial.

• Use the forum to collaborate, ask questions, get clarifications and share  
tips you learned while doing a lab.

• Plan for things to go wrong and give yourself time to ask questions and 
get answers.

• Late work is not accepted so submit what you have for partial credit.
218
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Wrap up
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New shell commands:
cal - show calendar
cat /etc/issue - usually shows distro (distribution) name
cat /etc/*-release - usually shows distro (distribution) name
clear - clear the terminal screen
date - show current time and date
exit - terminate your shell and log off
history - show previous commands
hostname - show the name of the computer being accessed
id - show user and group id information
ps - show processes (loaded programs) being run
ssh - secure login to a remote system
uname - show kernel name
tty - show terminal device
who - show everyone logged in
who am i - identifies which login session you are using

New Files and Directories:

VMware:

220
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Next Class

Assignment: Check the Calendar Page on the web site 
to see what is due next week.

Quiz questions for next class:

• What part of UNIX/Linux is both a user interface and a 
programming language?

• What is the lowest level, inner-most component of a 
UNIX/Linux Operating System called?

• What command shows the other users logged in to the 
computer?

221
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End
Meeting
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Backup
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UNIX/Linux
Commands 
on various 
systems

224
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Apple iPad
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Asus Router
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Samsung 
Galaxy
smartphone
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VMware
ESXi server
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HP-UX
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BSD Unix
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IBM AIX
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STEM Center
CIS Lab
Building 800

CTC
Room 1403


